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Welcome to another Adobe Photoshop Elements Techniques Bonus Edition! This special issue crams into 16 pages all the 
important things you need to know about Photoshop Elements 5. The folks over at Adobe have added the perfect mix 
of new ways to organize your photos, along with killer new tools for enhancing them; they’ve added some absolutely 
stunning ways to show off your photos that will amaze your friends and family; and they’ve added a whole new look. 
Don’t be alarmed—if you’re like me, you’ll absolutely fall in love with this new sleek look. Besides, it still behaves exactly  
as it used to so if you’ve used Elements before, you won’t skip a beat.

If you didn’t receive this bonus edition as part of a regular subscription to our newsletter, let me say that this is just a sampling of the 
kind of information you can read in each issue of Adobe Photoshop Elements Techniques. Normally, each issue is 28 pages of step-
by-step tutorials, tips, and Q&As (not to mention access to our subscriber-only website, www.photoshopelementsuser.com, filled with 
more tutorials and tips, a subscriber gallery, contests, and an incredibly active and helpful user-to-user forum).

I truly hope you enjoy learning all about the new version of Photoshop Elements. Even if you don’t upgrade right away (trust me 
though, you’re going to want to), at least you’ll have the knowledge and tools in your hand to know what’s out there. 

See you next time… 

Matt Kloskowski

Editor-in-Chief

mattk@photoshopelementsuser.com
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That sure is a loaded question. When a new version of an application comes out, many people ask if they should upgrade.  In 
the case of Photoshop Elements 5, I will sincerely tell you there are many reasons to consider upgrading, many of which we’ll 
cover throughout the pages of this bonus edition of Adobe Photoshop Elements Techniques. 

You may read of one new feature that is, for you, absolutely worth the price of an upgrade. There’s no question that the 
choice is a very personal one. It’s worth remembering that new tools and features are not the only reason for upgrading—soft-
ware manufacturers also make a lot of “under the hood” changes to improve performance and that alone makes the upgrade 
worthwhile for many users. 

Yes! Although Photoshop Elements 5 has a bunch of great new features, we won’t leave behind our readers who choose to remain 
with Photoshop Elements 4. Heck, even those using Photoshop Elements 3 will still be able to use the bulk of what you read in this 
newsletter. As much as possible, we’ll create tutorials that will work on all versions of the software, and if we ever do write about 
tools that are only in Photoshop Elements 5, we’ll make every effort to offer a solution that works in version 4 as well. 

This feels like déjà vu because many asked this question when Photoshop Elements 4 was released. Photoshop Elements 5 
is only available for the Windows platform, with no plans from Adobe to release a Macintosh version. In all honesty, we too 
would be happier if there were a Macintosh version of Photoshop Elements 5. Since there isn’t, we’ll continue along the  
same path we always have: to include Macintosh shortcuts for Photoshop Elements 4 wherever possible—and to indicate if  
a feature or tool is Windows-only.

If you’re already a subscriber of Adobe Photoshop Elements Techniques, you’ve probably made regular visits to our accompanying 
website that’s packed with tutorials, tips, and a very active user-to-user forum. If you haven’t checked these out, you’re missing 
out on a major benefit of your subscription. If this is your first time seeing our newsletter, please be sure to visit www.photo-
shopelementsuser.com to experience the world’s largest resource for Photoshop Elements. 

Although the user forum is free to all, the majority of the content on our site is one of the many benefits made available 
only to our subscribers. We add new content each week, which is one of the reasons why it has become the number one 
destination in the world for Photoshop Elements users.

In addition to the information in the newsletter and on the website, we also offer 21-day online Photoshop Elements 
training courses. There are currently four courses to choose from, with more to come in the future. Check them out at  
www.photoshopelementsuser.com/training_courses.

For more traditional educational options, check out the best-selling DVDs and books written by Adobe Photoshop  
Elements Techniques’ Executive Editor Scott Kelby, Editor-In-Chief Matt Kloskowski, and Contributing Writer Dave Cross  
all available at the website store.

If you want to expand your skills beyond Photoshop Elements into Adobe Photoshop and beyond,  here are a few excellent options: 
For Adobe Photoshop users, the National Association of Photoshop Professionals (NAPP) is the world’s leading resource for 

education, training, and news. It’s led by a world-class team of Photoshop experts, including the familiar faces of Scott Kelby, 
Dave Cross, and Matt Kloskowski. NAPP publishes Photoshop User magazine and produces the Photoshop World Conference 
& Expo. For more information about NAPP membership, go to www.photoshopuser.com or visit www.photoshopworld.com 
to find out more about NAPP’s conference. 

For people venturing into Adobe’s other graphics, Web design, digital photography, and video applications, Layers maga-
zine contains step-by-step tutorials, tips and tricks, and Q&As for everything Adobe, along with comprehensive reviews and 
industry news. You can go to www.layersmagazine.com for subscription information. ■

Photoshop Elements 
FAQ

 Should I upgrade to Photoshop Elements 5?

Will you still cover Photoshop Elements 4?

What about a version for the Macintosh?

What other resources are available?

I’m ready to move up to the next level—what are my options?

 FAQ 5.indd   2 7/24/06   3:18:34 PM
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rom downloading photos directly from your camera or 

card reader, to enhancing them in easy yet dramatic ways, 

all the way to sharing them in creative and simple ways, 

Photoshop Elements 5 has it all covered. Here’s a quick 

overview of the cool new features.

GETTING YOUR PHOTOS ONTO YOUR COMPUTER

When you first pop your camera or card reader into your computer, the 

Adobe Photo Downloader will appear. Even if you’ve used the Down-

loader before, it’s got some significant enhancements that make it even 

simpler and more powerful to use.

A new feature is that photos can be organized in groups based on 

the time they were taken. You can easily group the newest or related 

photos together in the Downloader according to how close in time they 

were taken to each other. The Photo Downloader can also automatically 

suggest photo stacks when you’re importing photos so you don’t have to 

manually go through them and do it yourself. Stacks are an easy way to 

group similar photos to save room in the Organizer (you can do this in 

the Organizer, as well, after you’ve imported your images). You can even 

set the Downloader to delete (or not delete) the photos from the card 

when it’s done downloading.

Once you get the settings in the Downloader just the way you like them, 

you can check the Automatic Download option and Elements will always 

automatically download your photos using the settings you entered. I rec-

ommend fitting this into your photo shooting workflow. In a single click you 

can transfer photos from your memory card to your computer according to 

preset preferences so you can get back to shooting sooner.

ENHANCING YOUR PHOTOS

There have been some pretty significant new additions for enhancing 

your photos as well, including Color Curves, which Dave Huss covers 

on page 8. This tool uses a proven curve technique for fixing bright-

ness, contrast, and exposure in photos—much like the one in the full 

version of Adobe Photoshop. However, the dialog takes much of the 

IT’S PRETTY CLEAR WHAT ADOBE HAD IN MIND WHEN CREATING PHOTOSHOP ELEMENTS 5—BRINGING OUT 
THE BEST IN YOUR PHOTOS. IT’S ALSO CLEAR THAT THEY DID THIS IN A WAY THAT GIVES US PLENTY OF POWER 
AND FLEXIBILITY AT THE SAME TIME. 

conquer the elements: 
an elements 5 overview
n  B Y  M A T T  K L O S K O W S K I
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The new enhancement 
features along with cool 

ways to show off your 
photos have really made this 

version worth the upgrade.
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Color Curves help fix 
brightness, contrast, and 

exposure in photos.

Before

after
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complexity of traditional curves away but still leaves you with plenty  

of power.

Another welcome new feature is the Convert to Black and White 

dialog, an advanced feature that Larry Becker covers on page 10. With 

this method, you get plenty of options for creating dramatic black- 

and-white photos. A new tool called Adjust Sharpness is now available 

for sharpening your photos, and there’s also a new filter for fixing  

any camera lens distortion that may occur. To see these tools in  

action, make sure to visit the Photoshop Elements 5 Learning Center  

at www.photoshopelementsuser.com/learningcenter. 

PHOTO CREATIONS

One of the most exciting announcements in Photoshop Elements 5 is the 

much-improved Photo Creations feature. These creations coupled with 

the new Artwork and Effects palette give you an incredible amount of 

flexibility and creative ways to show off your photos. Lynette Kent covers 

Photo Creations on page 6 while Dave Cross covers the Artwork and 

Effects palette on page 12. 

Another cool new feature that may slip by you is the ability to create 

multi-page documents. When making a Photo Creation you can just as 

easily choose to use several photos spread among several pages instead of 

putting them all on one page. The Photo Bin at the bottom of the Editor will 

group pages that belong together by highlighting them in a different color. 

SHARING YOUR PHOTOS

Also included are many additions for sharing photos. For example, with 

the Yahoo! Maps plug-in, you can drag photos onto locations on a map 

and Photoshop Elements will place small indicators wherever you drop 

the photos. Then you can share these maps with your family and friends 

to show them exactly where you’ve traveled.

New Flash-related features let you show off your photos. You can 

animate your photos using a number of pre-created templates. These 

animations really bring your photos to life and make for a visually 

appealing and interesting way to view photos.

If you want the look of a classic gallery you still have the Web galler-

ies available, which have been updated with some nice smooth Flash 

galleries as well. Jan Kabili shows how the new Flash galleries work  

on page 14.

Finally, there are even some enhancements and improvements to  

the sharing services. Just click on the little globe icon in the menu bar 

and you’ll see plenty of popular ways to share your photos by taking 

advantage of services from Kodak, SmugMug, Flickr, and even email  

and mobile phone options.

Photoshop Elements 5 is one slick upgrade. The new enhancement 

features along with cool ways to show off your photos have really made this 

version worth the upgrade. As always, make sure you visit the Online Learn-

ing Center at www.photoshopelementsuser.com/learningcenter for even 

more detailed tutorials, videos, and articles on Photoshop Elements 5. n 

F O R  M O R E  O N  P H O T O S H O P  E L E M E N T S  5 ,  V I S I T  
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a closer    look…
A quICK gLANCE AT SOME 

OF ThE NEW FEATurES AND 

ENhANCEMENTS IN ADOBE  

PhOTOShOP ELEMENTS 5.

Share your photos in animated fashion 
with Flash Web Galleries.
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Photo Creations allows you to create 
documents with multiple pages.

Yahoo! Maps plug-in allows you to drop photos 
onto a map for a pictorial travelogue.
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a quicker way to get creative
ALTHOUGH THE MAKE PHOTO CREATIONS BUTTON EXISTED IN THE PREVIOUS VERSION OF PHOTOSHOP ELEMENTS, 
THERE’S ADDED FLEXIBILITY AND CHOICES IN VERSION 5. IN FACT, WHEN COUPLED WITH THE NEW ARTWORK AND 
EFFECTS PALETTE, CREATIONS AND LAYOUTS BEGIN TO TAKE ON A LIFE OF THEIR OWN.

■  B Y  L Y N E T T E  K E N T

P        
hoto Creations include 

pages for photo layouts, 

album pages, greeting 

cards, as well as CD or 

DVD labels. You can even create up to 

30 pages at one time. It’s easy to design 

a travel album ready to print with the 

photos you select. Also, scrapbookers 

can quickly create multiple scrapbook 

pages with uniform or various styles.

You can start a Photo Creation from 

the Welcome screen by clicking on Make 

Photo Creations, but this only opens 

up the Photo Layout option. By 

clicking Create from the Organizer 

workspace, the Quick Fix work-

space, or the Full Edit workspace, 

you can open the drop-down 

menu to get more options. 

From here you can 

select a Photo Layout, 

Album Pages, Greet-

ing Card, CD Jacket, 

DVD Jacket, CD/DVD 

Label, Slide Show, 

Flash Gallery, Flipbook, Photo Calendar, 

or PhotoStamps®. Choose one of the top 

six Photo Creations (Photo Layout to CD/

DVD Label). This opens up the New Photo 

Layout dialog. [For more on creating Flash 

galleries, turn to page 14.—Ed.]

You’re free to change the size, layout, 

theme, and number of pages for any 

of your projects. You can even create a 

multi-page project with one theme, and 

then later change the background look and 

number of images on each page included 

in the project. In fact, you can start a Photo 

Creation without a theme and then add 

the theme after you place your photos.

FLEXIBLE CHOICES

Once you select a layout and template 

from the New Photo Layout dialog and 

click OK, your basic layout opens in the 

Editor workspace. Your original layout 

choice includes a certain number of frames 

or placeholders for photos. Click on one of 

the placeholders to fi nd and open a photo 

to place (make sure you’re in Full Edit 

mode), or if you have images open in the 

Photo Bin, simply click-and-drag a photo 

onto the placeholder in your page. You 

can also open the Organizer by clicking the 

Organize icon to fi nd a photo to open in 

the Editor. (Note: Alternatively, you could 

have selected the images in the Organizer 

before you chose Create>Photo Layout. 

This would have activated the option in the 

New Photo Layout dialog to Auto-Fill with 

Quickly create 
album pages, 

greeting cards, 
and calendars.

 PhotoCreations_Bonus5.indd   1 7/24/06   9:41:56 AM



Selected Images from the Organizer and 

the option to Include Photo Captions.) 

If you want to replace a photo in 

your creation with a different one, just 

Right-click the photo and select Replace 

Photo from the drop-down menu. You’ll 

probably have to adjust the photo to fi t 

the frame. Double-clicking the photo with 

the Move tool (V) puts a selection border 

around it. Click within the selection border 

and drag the photo to reposition it, or drag 

the slider to resize the photo within the 

frame. Click the Commit button (check-

mark) to fi nish the adjustment. 

Want to change the size of the framed 

photo? No problem. Click the photo just 

once and a selection border for the photo 

and frame combination appears. Drag 

the Move tool over a corner anchor and 

click-and-drag to resize the image and the 

frame at the same time. You can also rotate 

the photo within the frame or the photo 

and frame together. The selection border 

includes a circle below the bottom center 

anchor point. Using the Move tool, click-

and-drag the circle to rotate the selection.

To move the photo and frame to a dif-

ferent location, just click-and-drag on the 

photo. To add another photo and frame, 

click the photo frame to select it. The layer 

is also highlighted in the Layers palette. 

Right-click the highlighted layer in the 

Layers palette and select Duplicate Frame. 

Click-and-drag the photo and frame to 

F O R  M O R E  O N  P H O T O  C R E A T I O N S ,  V I S I T 
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another location on the page. Right-click 

on the moved photo and select Replace 

Photo. Be sure to click the Commit button 

if you’re in the middle of a photo edit, as 

you’ll not be able to Right-click to replace 

the photo when the slider bar is open.

OPTIONS, OPTIONS, AND MORE OPTIONS

Now it’s time 

to get creative 

and customize 

your pages by 

adding artwork 

and effects 

from the 

aptly named 

Artwork and 

Effects palette. 

(If for some reason this palette isn’t open, 

click Window>Artwork and Effects.) You 

can change the frame and background 

style and add different graphics or shapes 

using the far left icon (Artwork) at the top 

of the Artwork and Effects palette. 

You can scroll through all the pos-

sibilities at once by selecting All in the 

left drop-down menu, or just select the 

Backgrounds or Frames, for example, 

and choose a category from the right 

drop-down menu. You can change and 

add individual frames and backgrounds 

or add shapes and 

graphics to deco-

rate your pages.

Want to change 

the complete theme 

for the page? By 

clicking the Theme 

icon in the Artwork 

and Effects palette, 

you can select from 

a myriad of prede-

signed themes to 

change the back-

ground and the 

frame style at once.

The third icon in the Artwork and 

Effects palette opens a menu of Photo 

Effects, Filters, and Layer Styles that you 

can add to individual parts of your cre-

ation. For example, to add a drop shadow, 

click on an item in your creation with the 

Move tool. Then, select Layer Styles in the 

left drop-down menu and Drop Shadows 

in the right drop-down menu in the pal-

ette. Double-click any of the drop shadow 

styles to apply it. You can also click-and-

drag any of the effects from the palette 

onto a photo to apply the effect.

Using the Type tool, add text anywhere 

on your page. While the text is selected, 

choose the Text icon in the Artwork and 

Effects palette to apply effects to the text, 

such as Emboss or Gradient. [For more on 

the Artwork and Effects palette, turn to 

page 12.—Ed.]

A WORD OF CAUTION...

Making photo creations and customizing 

them can be very addicting. You can move, 

rotate, add items, change styles, and apply 

effects in so many ways, it’s diffi cult to 

stop trying different looks for your layouts. 

Just remember one of the golden rules of 

basic design: Less is more. Stop when your 

page looks good. If you want to try more 

options, start a new creation! ■

In addition to writing for several magazines, Lynette Kent is an artist/photographer and writes books including Top 100 Simplifi ed Tips and Tricks with Photoshop CS2, 
Scrapbooking with Photoshop Elements, and Teach Yourself Visually Digital Photography (co-authored with Dave Huss).
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Technically, Adjust Color Curves is similar to the 
existing Levels command. It takes input tones and 
selectively stretches or compresses them. But Lev-
els has only black, white, and midpoint controls—a 
tonal curve is much more versatile. Adjust Color 
Curves improves a photo by adjusting highlights, 
midtones, and shadows in each color channel.

STEP ONE: With an image open, choose 
Enhance>Adjust Color>Adjust Color Curves, 
which launches a large dialog. There are six 
thumbnail previews (called Samples) of the 
selected image, each showing the effect of a  
different setting. The first five—Increase Mid-
tones, Increase Contrast, Lighten Shadows, 
Darken Highlights, and Backlight—are all tonal 
adjustments. The last Sample, Solarize, is quite 
different from the Solarize filter that’s found in 
the Stylize section of the Filter menu. It produces 
some surprising results when applied to objects 
and landscapes. 

STEP TWO: Click one of the samples and the 
image changes to reflect the selected option.  
You can preview the effect on the image by mak-
ing sure Preview is checked at the bottom of the 
dialog. Remember that every change made in 
one tonal area of the image will impact another. 
To demonstrate, look at this original image of 
the Venice Canal. If the Increase Contrast option 
is selected, the change makes the photo look a 
lot more vivid; but the areas in shadow become 
almost black.    
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MANY PROFESSIONAL ADOBE PHOTOSHOP USERS LOVE THE CURVES ADJUSTMENT TOOL, A METHOD OF CHANGING  
THE TONES OF VARIOUS COLOR CHANNELS. ADOBE PHOTOSHOP ELEMENTS HASN’T HAD THAT TOOL—UNTIL NOW. 
PHOTOSHOP ELEMENTS 5 FEATURES A SIMPLIFIED VERSION OF CURVES, CALLED ADJUST COLOR CURVES. SO WHAT  
EXACTLY HAPPENS TO YOUR IMAGE WHEN YOU ADJUST THE COLOR CURVES?

color curves ahead

B Y  D A V E  H U S S 

Color Corrections

Original

Increase Contrast Color Curve
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STEP THREE: On the other hand, if you want to 
bring out detail in the shadows, click the Lighten 
Shadows thumbnail. Notice while the detail in 
the shadows is now much more apparent, the 
overall contrast of the image has been softened: 
It seems as if we’re viewing it through a slightly 
opaque piece of glass. Note: Each time you click 
a different Sample preview, your image changes 
to the selected setting, but the effects are not 
cumulative. If you want more than one adjust-
ment, after clicking OK, open the dialog again to 
make another adjustment. 

STEP FOUR: Sometimes the preset Sample curves 
aren’t enough to do the job. This photo taken at 
Pompeii is a classic example of a backlit image 
where the backlighting puts the subject in the 
dark. Applying the Backlight curve helps, but it 
isn’t quite enough. 
 

STEP FIVE: After applying the Backlight curve 
as a starting point, click on the triangle next to 
Advanced Options to reveal additional controls. 
If you want, you can close the Samples portion 
of the dialog by clicking on the arrow to the left 
of the Samples title. The Samples don’t reflect 
any of the adjustments made by the Advanced 
Options sliders, so it’s not imperative to keep 
them open.

The sliders are much more customizable and 
advanced than the presets. Moving the Adjust 
Shadows and Midtone Brightness sliders to the 
right brightens the dark foreground subject while 
leaving the bright overcast sky unchanged. You 
can’t, however, click-and-drag the points on the 
curve as you can in Photoshop. Experiment with 
the different Advanced Options sliders until you’re 
happy with the results. 

COLOR CURVE TIPS
Adjust Color Curves can be applied to a portion 
of the image if you first create a selection. This is 
really handy when you don’t need to adjust the 
entire image. You can also make a duplicate copy 
of the background and apply the change to the 
layer. This allows you to change the blending mode 
to create cool effects and to lower the Opacity if 
the effect of a curve is too intense. You can also 
remove portions of the modified layer that you 
don’t want. ■
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f o r  m o r e  t i p s  o n  C o r r e C t i n G  C o L o r ,  v i s i t

w w w . p h o t o s h o p e L e m e n t s u s e r . C o m 

Lighten Shadows Color Curve

Backlight Color CurveOriginal

Advanced Options Sliders

Dave Huss has more than 25 years’ experience as a photographer and has authored more than 17 books on digital photography and digital photo editing. His 
latest book is Adobe Photoshop Elements 4: 50 Ways to Create Cool Pictures.
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Photoshop Elements 5 Bonus Edition

It used to take special attention to camera aper-

ture and exposure and some time-consuming 

darkroom work to get a traditional high-quality 

black-and-white image. The new Convert to Black 

and White settings in Photoshop Elements 5 take 

advantage of not only light values but also color 

information—they can create all kinds of striking 

non-color effects.

STEP ONE: Let’s start by opening an image of a 

landscape you’d like to convert to black-and-white. 

Make a copy of the Background layer by pressing 

Control-J. Note: It’s a good habit to make a copy of 

the Background layer for any project in case you 

need the original later. Just remember to save your 

image as a Photoshop Elements document and 

don’t flatten it. This will retain the layers and ensure 

that the original color image is still available. 

STEP TWO: Next, open up the new Convert to 

Black and White dialog (Enhance>Convert to  

Black and White). This tool has three sections to  

it. In section 1, Elements gives you some great 

black-and-white presets. This will be all most  

people need. But if you want even more control, 

it’s available. When selecting a preset style, play a 

bit and pick the one you like best. Just make sure 

not to get hung up on the descriptions Adobe 

uses for the various conversion settings. Consider 

the name as a starting suggestion and experiment 

from there. For instance, there are some landscape 

images that look more “vivid” with Scenic Land-

scape than with the Vivid Landscapes setting.
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THE SECRET TO GREAT BLACK-AND-WHITE IMAGES ISN’T SIMPLY TO REMOVE COLOR FROM A GREAT COLOR PICTURE. 
CONVERTING AN IMAGE TO GRAYSCALE USING ENHANCE>ADJUST COLOR>REMOVE COLOR OFTEN RESULTS IN A DULL, 
LIFELESS GRAYSCALE IMAGE. DEPENDING ON YOUR SUBJECT, YOU SHOULD EMPHASIZE CERTAIN COLOR FAMILIES (REDS, 
GREENS, OR BLUES) AND DE-EMPHASIZE OTHERS WHEN YOU CONVERT COLOR IMAGES—THIS AMPLIFIES CONTRAST AND 
DETAIL, CREATING THE FEEL YOU INTEND.

don’t settle for dull, boring  
black-and-white images

B Y  L A R R Y  B E C K E R

Photographic Effects
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STEP THREE: If you can find a preset in section 1 

that makes your image look the way you want,  

just click OK and you’re done. If you want more 

control over the intensity of various aspects  

of your conversion, you’ll want to experiment  

a little with the Adjustment Intensity slider  

(section 2) and the variation buttons (sec- 

tion 3). We’re actually going to talk about  

section 3 first.

 In section 3, you’ll see buttons for adding 

More or Less Red, Green, or Blue and for adding 

More or Less Contrast. When you click on one 

of these buttons, the Custom option in section 1 

becomes active and is selected. You’re no longer 

using one of the presets as a style. You can click 

the same button multiple times or click various 

buttons. Each time you click a button, all of the 

other buttons update based on the last button 

clicked. Don’t worry if your adjustments get out  

of hand; you can always press the Reset button  

in the dialog to get your image back to the way 

you started.

STEP FouR: If you need even more control, use 

the Adjustment Intensity Slider in section 2. It’s 

important to note that the Adjustment Inten-

sity slider doesn’t affect the section 1 presets. It 

changes the intensity of the section 3 buttons. 

You’ll probably want to adjust the intensity of  

the section 3 buttons before you start clicking  

on them to make changes to your image. Be  

sure to watch the previews in section 3, while 

moving the slider, to see how intense your 

changes will be. The slider is very sensitive,  

so you’ll probably only want to move it very  

little. If you move the slider left of center, the 

Contrast buttons in section 3 will actually do  

the opposite of what their label says, so More 

Contrast will result in lower contrast images. If 

you move the slider to the right of center, the 

More color buttons become Less and the Less 

color buttons become More. n

Larry Becker is a nationally known author, speaker,  
and technology trainer whose areas of expertise range  
from digital imaging, desktop publishing, and computer-
based video and music to PDAs, smartphones, and the 
occasional garage-door opener. Larry also conducts  
training seminars for the Adobe Photoshop Elements  
Techniques newsletter and website.
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Final black-and-white converted image
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Photoshop Elements 5 Bonus Edition

here are five icons in  

the Artwork and Effects  

palette that represent the 

options from which you can 

choose: Artwork, Themes, Special Effects, 

Text, and Favorites. In each of these main 

categories there are literally hundreds of 

choices. For example, the Artwork palette 

includes Backgrounds, Frames, Graphics, 

and Shapes, and each of those main cat-

egories includes various subcategories. In 

turn, each subcategory contains anywhere 

from 5 to 25 individual graphics.

To use one of the graphics in the 

Artwork palette, just choose the main 

category in the left pop-up menu, then 

the subcategory in the right pop-up menu, 

and choose from the individual pieces of 

art. To add one of the graphics to your 

existing document, simply double-click 

COMBINE SOMETHING OLD (FILTERS AND EFFECTS) WITH SOMETHING NEW (ARTWORK AND THEMES) AND 
VOILÀ—YOU’VE GOT THE BRAND-NEW ARTWORK AND EFFECTS PALETTE. THIS IS YOUR ONE-STOP SHOP TO  
ADD GRAPHICS, APPLY THEMES, RUN FILTERS, ADD LAYER STYLES, AND MORE.

instant art: create eye-catching 
effects with just one click 
n  B Y  D A V E  c r o s s

T   
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on the graphic or drag-and-drop it from 

the palette onto your page. If you have 

the Show Bounding Box option (in the 

Options Bar) turned on for the Move tool, 

you can click-and-drag on a corner handle 

to resize the graphic. Click on the check-

mark or press Enter to finalize the sizing  

of the graphic.

For the example at the top of the next 

page, we went to the Themes palette’s 

Travel category and chose the Cruise 

graphic. After double-clicking on the 

graphic in the palette, things automati-

cally changed: a new layer was added  

and our photo was scaled down to fit 

into the “frame” in the chosen theme.  

We can reposition and scale our photo 

and the frame, if necessary. 

Considering the huge number of 

options available in the Artwork and 

With all its options, the 
Artwork and Effects 
palette is bound to 
become one of the 

most popular parts of 
Photoshop Elements 5.

Artwork palette Themes palette Special Effects palette Text palette

 ArtworkEffects.indd   1 7/24/06   9:54:51 AM



Effects palette, the Favorites option is 

sure to become a . . . favorite! As you find 

graphics, filters, and layer styles that you 

think you’re likely to use frequently, click 

on the graphic and then click on the Star 

icon at the bottom of the palette. Then 

click on the Favorites icon at the top of 

the palette to view all your favorites.

One of the advantages of these new 

graphics is that they’re quite scaleable—

they’ve been designed with resizing in 

mind. In our next example, we dragged  

a graphic of a magnifying glass onto a 

document, which resulted in a pretty  

small graphic (you can find this graphic 

in the Artwork palette in the School 

subcategory in the Graphics main 

category). Using Free Transform 

(Image>Transform>Free Transform),  

we rotated and scaled the magnifying  

glass considerably larger without any  

loss in quality.

ADDING YOUR OWN GRAPHICS

If all these graphics weren’t enough, you 

can also add your own graphics into the 

f o r  m o r e  t i p s  o n  s t y l e s  a n d  e f f e c t s ,  v i s i t

w w w . p h o t o s h o p e l e m e n t s u s e r . c o m 
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Artwork and Effects palette so they’re 

accessible anytime you need them. First, 

create your graphic on a separate layer 

above the Background layer. Hide the 

Background layer by clicking on its Eye 

icon, so you have transparency around 

your graphic.

Next, use File>Save As and save your 

graphic as a PNG file (choose PNG in the 

Format drop-down menu). You’ll need  

to put this graphic into the following 

location: C: Documents and Settings/ 

All Users/Application Data/Adobe/Photo-

shop Elements/5.0/Photo Creations/Art-

work/Graphics. If you like, you can create 

a new folder within the Graphics folder 

to add a subcategory for your graph-

ics (in this example we created a folder 

called “Mine”).

Quit and restart Elements and the Art-

work and Effects palette will be “rebuilt.” 

Now our graphic appears in the palette 

and can be dragged-and-dropped onto 

a photo anytime we need it. With all its 

options, the Artwork and Effects palette 

is bound to become one of the most 

popular parts of Photoshop Elements 5. ■
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Photoshop Elements 5 Bonus Edition

he first thing you need to 

do is select the photos to 

include in your Flash gallery. 

If you want to display cap-

tions in your final Flash gallery, Right-click 

each photo, choose Add Caption, and type 

a caption. Select the photos and videos to 

include in your Flash gallery by Control-

clicking or dragging over multiple image 

thumbnails in the Organizer. Click the Create 

button at the top of the screen, and choose 

Flash Gallery from the drop-down menu. 

The Flash Gallery Wizard window 

opens, displaying thumbnails of your 

photos in the column on the left. To add 

more photos, click the Add button at the 

bottom of that column. In the Add Photos 

dialog, choose the source of the additional 

THE FLASH GALLERY IN ADOBE PHOTOSHOP ELEMENTS 5 OFFERS AN EASY WAY TO DISPLAY YOUR PHOTOS ON 
THE WEB AS A SLIDESHOW, A PHOTO GALLERY, AN ANIMATION, OR AN INTERACTIVE SITE. THIS NEW FEATURE 
OFFERS LOTS OF COOL FLASH TEMPLATES TO SHOW OFF YOUR PHOTOS, AND IT AUTOMATICALLY CREATES A 
WEBPAGE WITH AN ACCOMPANYING FLASH FORMAT (SWF) FILE.

show off your photos in a
flash with interactive galleries
n  B Y  j a n  k a B i l i

T    
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photos, check the box next to each image 

you want to add, and click Done to return 

to the Wizard. To delete a photo, click on it 

in the Photos column and click Remove.

TEMPLATES AND STYLES

Elements offers multiple Flash gallery tem-

plates. From the top of the Flash Gallery 

Wizard, click the Type drop-down menu 

to view three categories of templates. Web 

Galleries are full webpages that present 

your photos as slideshows or galleries. The 

Animated category includes an animated 

template to show off your kids or pets, a 

template that features your photos hang-

ing on a simulated wall, a template made 

for wintertime photos, and a vacation-

themed template. The Interactive category 

includes templates that put your photos 

into simulated 35mm slides, onto an old 

map in postcard-style frames, and even 

on a merry-go-round (plus much more).

While the Web Galleries and Animated 

categories are also interactive, the neat 

thing about the Interactive category is 

the ability to click and move the framed 

images around the screen. There’s even a 

book template where you click-and-drag 

the pages to turn to the next photo.

Let’s illustrate this fun way of displaying 

your photos by using Web Galleries. With 

Web Galleries selected in the Choose a 

Template area, drag the horizontal scroll 

bar to browse through the template 

…the neat thing 
about the Interactive 
category is the ability 

to click and move 
the framed images 
around the screen.
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thumbnails, clicking on each to see a 

brief description. Select the fi rst tem plate 

called Standard (Small Thumbnails). Each 

of the templates is available with different 

styles that vary in colors and background 

images. In the Choose a Style area, select 

the Deep Purple style. 

CUSTOMIZE YOUR FLASH GALLERY

Click the Next Step button at the bottom 

of the Wizard to move to the next screen, 

where you can customize your Flash 

gallery. The settings you’ll see here vary 

depending on the template you chose. 

In the Customize column on the left, 

check Show Title Bar. Enter text in the Gal-

lery Title and Gallery Caption fi elds. This 

text will be dis-

played in the 

title bar. (Click 

the Refresh 

F O R  M O R E  O N  P H O T O S H O P  E L E M E N T S  5 ,  V I S I T 
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button under the preview area 

to update the preview of your cus-

tomized gallery.) In the About This 

Gallery fi eld, enter text about your 

photos. That message will appear 

when a viewer clicks the View 

button in the gallery menu bar 

in a Web browser and chooses 

About these Photos. Enter text in the Your 

Name and E-mail Address fi elds to create 

an email link to your address that a user can 

access from their Web browser.

The Standard template displays your 

photos as a slideshow or one by one. In 

the Slideshow area of the Customize 

column, enter the number of seconds 

you want each slide to appear onscreen 

during the slideshow. From the Transi-

tion Effect drop-down menu, choose an 

effect for the transition between slides.

In the Optimize For drop-down menu, 

choose whether your Flash gallery will con-

tain large images suitable for viewers with 

broadband Internet connections or medium 

images that will download more quickly for 

viewers with slower dial-up connections.

Drag the vertical scroll bar on the Cus-

tomize column to see more custom settings. 

In the Background area, you can change the 

color of different parts of your gallery. (Try 

clicking the Color box labeled Slideshow. 

In the Color Picker 

that opens, choose 

a darker purple and 

click OK.) Use the 

Button Opacity sliders 

to change the opacity 

of the gallery buttons. 

The Title Bar and 

Menu Bar settings let 

you change colors 

in those areas. In the 

Thumbnail Effects 

area you can custom-

ize the color of the 

borders around your 

photo thumbnails when you hover over 

them or select them. If you added captions 

to your photos in the Organizer, check Show 

Captions to display those captions under 

each photo. Or check Show File Names to 

display a fi le name under each photo.

PREVIEW AND SAVE YOUR GALLERY

Click the Refresh button under the preview 

area to preview your fi nal customized 

gallery in the Flash Gallery Wizard. Use 

the Play and Pause Slideshow buttons to 

start or stop the slideshow. You can display 

the photos one at a time by clicking the 

Next Image or Previous Image buttons 

under the large photo, or by selecting a 

specifi c thumbnail on the left side of the 

gallery. If you have more than one screen 

of thumbnails in your gallery, click the 

buttons under the thumbnails to navigate 

through them. Click the View Slideshow 

button under the large photo to switch to 

slideshow-only view.

Some of your customized settings may 

not be visible in the Flash Gallery Wizard. 

To preview them, click the Preview in 

Browser button under the preview area. 

Your default Web browser will open with 

a working preview of your Flash gallery.

Back in the Flash Gallery Wizard, enter 

a name for your gallery in the Save Gallery 

As fi eld. From the Output Options drop-

down menu, choose an output method. 

If you have an FTP (fi le transfer protocol) 

site for your Web fi les, choose Share to My 

FTP Site. Alternatively, choose Burn to CD 

to send the fi les to a CD, or Export to Com-

puter to save the fi le to your hard drive. 

Choose Do Not Output to save the gallery 

for further editing before you output. Click 

the Browse button to choose a location on 

your hard drive to which to save a copy of 

your Flash gallery. You can even save your 

changes as a new style to use for future gal-

leries. And fi nally, click the context-sensitive 

Share/Burn/Export/Save button. ■
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The Interactive templates offer showy 

photo browsers, like this page-turner. 
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Jan Kabili is a popular Photoshop author and trainer. Her latest book is How to Wow: Photoshop CS2 for the Web. You can read her regular column, 
“Photoshop for Educators,” in Photoshop User magazine.
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To view  the entire “Watery Type”  video tutorial and learn even more    
         about the new features of Photoshop Elements 5, log into the

        subscriber section at www.photoshopelementsuser.com.

Web Video Tutorial Spotlight
 Watery Type, By Dave Cross

•  Over 100 AMAZING PRINT AND VIDEO TUTORIALS
from Scott Kelby, Dave Cross, Matt Kloskowski, 
and many others

•  A SCRAPBOOKING section with tutorials devoted to 
creating beautiful digital scrapbook designs

•  An online GALLERY where you can share your own 
creations as well as peer-to-peer discussion forums 

•  Tons of DOWNLOADABLE PLUG�INS AND 
EXTRAS including shapes, patterns, layer styles, 
and brushes

Your printed newsletter is only a fraction of the education you get from your Photoshop® Elements 
Techniques subscription. The subscriber-only section of the website off ers tons of additional resources 
that add so much to your learning experience.

Essentials

www.photoshopelementsuser.com or call 866-808-2793

STEP 1:  Add  text to your image. Duplicate and Simplify text layer. STEP 2: Add or subtract random shapes to layer.

STEP 3: Apply the Ripple, Emboss, and Gaussian Blur fi lters. STEP 4: Change the blend mode to Hard Light to complete effect.
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